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WORD PROCESSING 

Word Processing software is an application which allows typing text, formatting them and saving it for future 

use. Extension of the word document for the version 2003 and earlier was .doc while extension of the word 

documents for the version 2007 and later is .docx. 

List of Word Processing Package 

Star Office/ Open Office  Microsoft Word  WordStar  Word Perfect 

WordPro   AppleWorks  GoBe Productive AbiWord 

Ability Write   602Text  Nisus Writer Express Mariner Write 

WordExpress   Thinkfree Office  CopyWrite  TextShield 

KWord    WordPad   

Different Version of Microsoft Office 

Office 4.3 Office 97, Office 2000, Office xp, Office 2003, Office 2007, Office 2010, Office 2012, Office 2013 
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Some commands and their menu in MS Word 2003 
Word Menu Word Menu 

Auto Correct Option Tools LanguageThesaurus Tools 

AutoShape Insert-Picture New File 

Autosummarize Tools Open File 

Autotext Insert Page No. Insert 

Bookmark Insert Page Setup File 

Border & Shading Format Paragraph Format 

Break (Page/Column) Insert Paste Edit 

Bullet and No. Format Picture Insert 

Change Case Format Print File 

Chart Insert Print Preview File 

Close File Protect Document Tools 

Column Format Redo Edit 

Comment Insert Replace Edit 

Copy Edit Ruler View 

Cut Edit Save File 

Diagram Insert Select All Edit 

Document Map View Spelling & Grammar Tools 

File Insert Symbol Insert 

Find Edit Tab Format 

Font Format Text Box Insert 

Footnote InsertRef. Toolbar View 

Go To Edit Track Change Tools 

Header and Footer View Undo Edit 

Hyperlink Insert  Word Count Tools 

Index and Tables InsertRef. WordArt Insert 

 

 

 



Smart InfoTech 

[A Corner for Computer Learners] 

Handout: Word Processing (Computer Operator) 

3 

Smart InfoTech     Kirtipur, Kathmandu          facebook.com/smartinfotechnepal         01-4335490  9843521640, 9841649993 

MS WORD 2007 
HOME TAB 

For formatting of text [same as Formatting Toolbar and Formatting Menu in older version] 
 

 
 

 

 
 
    

 
  

 
 

 

 
 

 
 

INSERT TAB 

[To insert Pictures, Shapes, WordArt [Same as Insert Menu and Drawing Toolbar] 
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PAGE LAYOUT TAB 

[Page Setup and other options] 

 
 

 

 

 
 

 

REFERENCES TAB 

[Like > Insert > Reference]      [Like > Tools > Letter and Mailing]    

 
 

 

 

 

REVIEW TAB 

[Grammar and other options] 
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Spelling and Grammar   Thesaurus (Word Meaning)          Protecting Document with password 
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VIEW TAB 

Different options to view the document [like View Menu] 

 

 

 

 

 

Customizing Toolbar 

 Click ‘Customize 

quick access 

toolbar’ button  

 Tick the buttons 

required 
 
 

 

FORMAT TAB 

Formatting Picture 

 Select the picture first 

 Click ‘Format’ tab 

 Change desired formatting 
 

 

Formatting Shapes 

 Select the shape first 

 Click ‘Format’ tab 

 Change desired formatting 

File options (opening, saving, 

closing document) 

[like File Menu] 

 Click the office button  

 Select required option 
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Inserting Shapes     Changing Shape styles       Line Color   Shadow Style 3D style  Text Wrapping  Changing size 
       and Fill Color    
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Some Shortcut Keys for Formatting Text 
 Align Left : Ctrl + L 
 Center : Ctrl + E 
 Align Right : Ctrl + R 
 Justify : Ctrl + J 
 Bold : Ctrl +B 
 Italic : Ctrl +I 
 Underline :  

o Normal Underline: Ctrl + U 
o Double Underline: Ctrl +Shift + D 
o Word Underline: Ctrl + Shift + W 

 Font select : Ctrl + Shift + F 
 Font size select : Ctrl + Shift + P 
 Font size increase : Ctrl + Shift + > 
 Font size increase by 1 pt: Ctrl + ] 
 Font size decrease : Ctrl + Shift + < 
 Font size decrease by 1 pt: Ctrl + [ 
 Font size select: Ctrl + Shift + P 
 Line Spacing : 

o single (1) : Ctrl + 1 
o Double (2) : Ctrl + 2 
o 1.5 : Ctrl + 5 

 Bullets: Ctrl + Shift + L 
 Increase Indent: Ctrl + M 
 Decrease Indent: Ctrl + Shift + M 
 Heading: 

o Heading 1: Ctrl + Alt + 1 
o Heading 2: Ctrl + Alt + 2 
o Heading 3: Ctrl + Alt + 3 

 

Title Bar Tabs 

Status Bar 

Scroll Bar 

Zoom Bar (Slider) 
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LIMITATION OF WORD 

 Number of column in a table: 1 to 63 

 Number of rows in a table: 1 to 32767 

 Zoom: 10 to 500% 

 Number of news paper column: 1 to 45  

 Paragraph space: -1 to 1584 pt 

 Indent: -55.87 to 55.87 cm (22 inch) 

 Scale (Character Spacing): 1 to 600% 

 Minimum paper size: .26 * .26 cm (0.1 inch) 

 Maximum paper size: 55.87 *55.87 cm (22 inch) 

 Default Font: Times New Roman (2003), Calibri 

(2007) 

 Default Font size: 11(2007), 12(2003) 

 Recent File list: 10 (0 to 9) 

 Number of copies of for printing: 1 to 32,767 

 Maximum size of ms word file : 32 MB 

 Maximum number of bookmarks: 

2,147,483,647  

 (Style Definition) maximum number of styles: 

4,079  

 Maximum number of comments:2,147,483,647  

 Maximum number of fields: 2,147,483,647  

 Number of subdocuments in a master 

document:255 

 Maximum number of moves: 2,147,483,647  

 (Range Permission) maximum number 

allowed: 2,147,483,647  

 Size of file Word can open: 512 MB 

 Maximum number of records to display in 

recipients list dialog: 10000 

 

SOME NOTES 

Different underlines 

Red underline: Means the flagged text is not in 

Word's dictionary  

Green underline: Indicates the text may be 

incorrect grammatically  

Blue underline: correctly spelled word used 

inappropriately  

Different View Options: 

Normal View (Ctrl + Alt + N): The default view 

option is Normal. In this option, all you see is the 

body of the document. This view is used for typing 

when you are not concerned with the layout of the 

document.  

Web Layout: This view option shows the same 

document if it were loaded on the internet. The 

formatting on the World Wide Web ignores any 

prior settings. If you are using MS Word as an editor 

for web pages, this is a good view option to 

remember. 

Print Layout (Ctrl + Alt + P): This option will let you 

see the document from a distance with all the 

borders and page breaks. Typically this view option 

is used when you want to print a page. 

Outline (Ctrl + Alt + O): A view that shows the 

headings of a document indented to represent their 

level in the document's structure. Outline view 

makes it easy to move quickly through a document, 

change the relative importance of headings, and 

rearrange large amounts of text by moving 

headings. Outline option is used in cases where you 

have table of contents or a similar document.  

Document Map: Outline of the documents appears 

at left side of the document from where we can 

navigate to desired location on page. 

Task Pane (Ctrl + F1): To show/hide taskpane at side 

of the document 

Section Break 

Section break  is used to create different sections in 

same ms word document so that different page 

formatting can be applied to different portion or 

section of same document. Some changes that can 

be applied to individual portion(section) of same 

document are given below: 

 Margins 

 Paper size or orientation 

 Page borders 

 Headers and footers 

 Page numbering 

How to break the section? 

 Click on the page where we section break is 

to apply 

 Click the Page Layout tab on the Ribbon. 
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 Click the Breaks button. 

 Select the desired section break type: 

o Next Page – forces the text following the 

break onto the next page. 

o Continuous – does not change the location 

of the text following the break. 

o Even Page – forces the text following the 

break onto the next even page. 

o Odd Page – forces the text following the 

break onto the next odd page. 
 

How to give different page number format In 

different section? 

 give desired page number with desired 

format 

 click on the header or footer page of new 

section 

 click  the 'Link to Previous' to remove its 

selection 

 select  new page number format 

Hyperlink 

Hyperlink is the link of text from a document to 

another document 

 Select the text to link 

 Under 'Insert' tab click 'Hyperlink' (Ctrl + K) 

 Select the file to link  

 OK 

Bookmark 

It is the mark in any place in document which allows 

to navigate (move) to the marked place any time 

needed  

Adding Bookmark 

 Select the text  

 Under 'Insert' tab click 'Bookmark (Ctrl + 

Shift +F5) 

 Give bookmark name 

 Click ‘Add’ 

Moving to the bookmark 

 Under 'Insert' tab click 'Bookmark 

 Click bookmark name to move 

 Click ‘Go To' 

 Close 

Table of Content 

To insert table of content in document 

 Select the heading to include in table of 

content in document 

 Under 'Home' tab select desired heading or 

sub heading 

 After applying heading to all click 

'References' Tab > 'Table of Contents' > 

'Insert Table of Contents' 

 Select desired format and tab header 

 OK 

Citation and Bibliography 

Citation is used to add sources in research 

document 

Adding Citation 

 Place the cursor at the end of the sentence 

or paragraph  before the full stop 

 Click 'References' tab  

 In the 'Citation and Bibliography' group click 

'Style' button arrow 

 Select any style 

 Click 'Insert Citation' > 'Add New Source' 

 Select the type of source 

 Fill required fields 

 OK 

Bibliography 

Bibliography contains list the book, journal or other 

sources used in the research document 

 Click 'Manage Sources' 

 Click 'Copy' to copy items of master list to 

current list if not appeared 

 Close 

 Click 'Bibliography' button > 'Insert 

Bibliography' 

Mail Merge 

It is the stepwise process to prepare a letter in 

different recipients’ name 

 Under ‘Mailing’ tab click ‘Start Mail Merge’ 

 Click ‘Step by Step Mail Merge Wizard’ 

 In the first step select 'Letter' option at top 

 Click 'Next : Starting Document' 

 Select 'Use Current Document; 

 Click 'Next : Select Recipients' 

 For first time, Select 'Type a new list'  
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 Click ‘Create’ and type name, addresses and 

other information about recipients (click 

‘New Entry’ to add new contact) 

o After all entry Click ‘OK’ 

o Give name and save the list   

o OK 

[From next time, select ‘Use an existing list’ and 

click ‘Browse’ to open the contact list] 

 Click ‘Next: Write your letter’ 

 Start typing letter  

 To insert name and address of recipient 

click ‘Address Block’ from right pane in 

required place in letter. 

 After finishing typing the letter click ‘Next: 

Preview your letter’  

 Click      button to view the letters in 

different recipients name  

 At last click ‘Next : Complete the merge’  

 Now, the letter is ready to print. Click ‘Print’ 

option at right to print the letter or save the 

letter for future.  

Making shortcut keys 

To create shortcut keys for desired command 

e.g. to create shortcut keys for inserting picture 

from file 

  Click on Office button > word option 

 Customize > Keyboard shortcuts > 

customize 

 Select desired category/ menu (e.g. Insert) 

 Select desired command from the list (e.g. 

InsertPicture) 

 Click press new shortcut key box and press 

desired shortcut keys  in keyboard (E.g. 'Alt 

+ P') 

 Click 'assign' > Close 

SOME TERMINOLOGIES 

 Alignment: Alignment refers to the position of lines in a paragraph in relation to the documents left and 

right margins 

 AutoCorrect: AutoCorrect continuously checks your document for misspelled and unrecognized words and 

for grammar errors. Right-click a word with a wavy red or green line beneath it to see a menu of alternatives. 

 AutoFit: Use the AutoFit command to format each column to the width of the widest entry in that column. 

 AutoFormat: AutoFormat is a feature that automatically changes text as you type.  

 AutoText: AutoText refers to text and graphics that can be named, stored, and reused in Word documents. 

 Bullets: Bullets are special characters or symbols that are used to set off a paragraph.  

 Catalog: Catalog refers to a type of document created in Mail Merge that contains multiple records per page. 

 Cell: A cell is the intersection of a row and a column in a table. 

 Clip Art: Clip art consists of pre-designed images that can be placed within a document. 

 Collate: Use the Collate option in the Copies area to have Word print complete, multiple-page documents 

before printing any subsequent copies of the same document. 

 Columns In a document, columns refers to the formatting of text so that it flows side-by-side on a 

page like a newspaper. 

 Data Form: A data form is a dialog box that allows you to view and edit individual records in a database. 

 Data Source: A data source contains the information from which a merged document is created. The data 

source is merged with a main document, which specifies the kind of output required. 

 Database: A database is a collection of organized information. 

 Database Field: A field is a specific category of information in a database. Some examples of possible fields 

are Name, Telephone Number, and Address. 

 Default: Default means standard. Default settings are the settings that Word uses unless you ask it to use 

other settings. 

 Document Field: A field is an area in your document where a specific type of data is entered or calculated. 
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 Drag-and-drop: Drag-and-drop is a feature that allows you to move or copy information without using the 

Windows Clipboard. To use it, you simply drag a selected item from one location to another. It is best used 

for moving or copying small items short distances. 

 Font: A font is a style and size of type, such as Times New Roman, 12 point, bold. A font is a set of all the 

characters available in one typeface and size, including uppercase and lowercase letters, punctuation, and 

numerals 

 Font Formatting: Font Formatting changes the appearance of the text. Font formatting includes 

enhancements such as font style font size (12 pt) 

 Footer: A footer is the contents of an area located within the bottom margin of a page 

 Format Painter Format Painter is a Word command that allows you to copy the formatting of one 

paragraph and apply it to another paragraph. 

 Gridlines: Use the Gridlines command on the Table menu to display thin dotted lines around the cells of a 

table. Gridlines do not print. 

 Header: A header is the contents of an area located within the top margin of a page. 

 Heading Styles: Heading styles refers to the nine predefined styles, called Heading 1 through Heading 9, that 

determine the size, numbering, and position of document headings 

 Headings: If a table breaks to two or more pages, headings can be applied so that they appear at the top of 

each page. 

 Indentation: An indentation is an amount of space measured from the page margin that is applied to a 

paragraph or an area of a document. 

 Index Card: The Index card contains the titles of Help topics and subtopics that are organized alphabetically, 

like an index in a book. 

 Inline Picture: Use an inline picture when you want the picture to be connected to the text around it, so that 

when you insert or remove any text in the document, the picture moves with its text.  

 Insert Mode: Type using the Insert mode to insert text in the existing document. Insert mode is the default 

mode of Word 97 

 Insertion Point: An insertion point is the place where text or graphics will appear in the document. It point is 

the flashing vertical bar that indicates the current position in the document. 

 Line Spacing: Line spacing refers to the number of lines used by each line of text.  

 Main Document: A main document is a type of document available in Mail Merge, such as form letters that 

can be combined with a data source to produce unique outputs. 

 Margin: The margin is the amount of blank space, usually measured in inches or characters, above and 

below and to the right and left of the main body of a document. 

 Menu Bar: The menu bar contains the names of Word's menus and is used to navigate through their 

commands. 

 Merge Cells: Use the Merge Cells command on the Table menu to combine selected cells in a row. This 

results in a single cell with the combined width of the original cells. 

 Non-printing Characters: Non-printing characters are those elements that can be seen in the document area 

of the screen, but that cannot be printed; e.g., paragraph marks, spaces, tabs, and gridlines. 

 Normal Style: Normal style refers to the default text style that Word uses as a basis for defining all other 

styles. 

 Normal View: View is Word's default document view and is the most practical view for performing such 

routine functions as typing, editing, and formatting. 

 Office Assistant: The Office Assistant gives you tips as you work, and it can be used to get help about Word. 
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 Outline View: Outline View provides a structured view of the document, arranging its contents according to 

heading levels and opening the Outlining toolbar for modifying the document's organization. 

 Overtype Mode: Overtype mode is the level of operation in Word where what you type replaces existing 

characters. Overtype mode is activated by pressing [INSERT]. 

 Page Layout View/Print Layout: Page Layout View shows the document's margins, headers and footers, 

frames, and other elements, thus providing a more accurate representation of what a document will look 

like when it is printed. 

 Paragraph: A paragraph in Word begins where you start typing, and it ends where you press  

 Paragraph Mark: The paragraph mark stores all the formatting styles for that particular paragraph and 

applies those styles to the text preceding it. 

 Quick Access Toolbar: A toolbar located in the upper-left corner of the program window, which displays the 

Save, Undo, and Repeat buttons by default but can be customized to include any command. 

 Ribbon: An area at the top of an office program window that contains commands for working with the open 

file; the commands are organized under tabs.  

  Scroll Bar: The scroll bar is a panel for moving the display horizontally or vertically within a window. 

 Section: A section is a part of a document defined by a section break that can contain Page Setup options, 

headers and footers, and other formatting such as text columns that are independent of other parts of the 

document, 

 Section Break: Section breaks are inserted using the Break dialog box, which is accessible by clicking Break 

on the Insert menu. 

 Selection Bar: The selection bar is an unmarked area in the left margin of a document that allows for easy 

data selection. When you click within the selection bar, you select the line directly to the right of the mouse 

pointer. 

 Shrink-To-Fit: Shrink-To-Fit is a Word command, available in Print Preview mode, that can reduce the pages 

of a document by adjusting its spacing and formatting. 

 Sort: Sort refers to the function of putting records in a certain order. For example, you could sort records 

alphabetically by last name. 

 Status Bar: Located at the bottom of the window, contains information about document  

 Tab: Tab is the key you press to move the insertion point to the next indicated tab stop. Word automatically 

sets tabs every half inch. 

 Tabs: Tabs are the titles of the cards found in some dialog boxes. Clicking one brings that card to the front. 

 Template: A template is a preformatted document that serves as a model for other documents.  

 Text Wrapping: Choose a Text Wrapping option in the Frame dialog box to specify whether text should move 

around the edges of a frame or stop above the frame and resume below the frame. 

 Toolbar: A toolbar is a group of tools of usually related functions. Toolbars can contain buttons, menus, or 

combinations of both that can be used to quickly perform actions in Word. 

 Windows Clipboard: The Windows Clipboard is a holding place in a computer's memory where data is stored 

after you use the Cut or Copy command. 

 Wizard: A wizard is a feature of Microsoft applications that lets you work through a series of dialog boxes to 

help you complete a task. 

 Wrapping Text: Wrapping text is an automatic feature of Word. When you reach the end of a line while 

typing, Word forces the text to break onto a new line.

 


